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1 INTRODUCTION 
The Prox-Booster, Smartcard-Booster and Transition-Booster are active dual ID tags enabling 
simultaneous identification of the inserted personal ID card and the embedded vehicle ID resulting in 
rapid driver and vehicle monitoring. 
 
A Proximity or Smartcard can be placed in the Booster unit. Additionally a separate ID (representing 
vehicle ID) is programmed in the Booster’s hardware. Once configured, the Booster allows a driver ID 
badge and embedded vehicle ID to be read from a distance up to 10 meters (33 feet) in combination with 
NEDAP TRANSIT readers. This solution substantially enhances the level of security when controlling 
activities of vehicles that are regularly used by different drivers. Additionally a fully integrated vehicle and 
personnel access solution can be implemented. 
 
For more details about the NEDAP TRANSIT reader refer to the TRANSIT installation guide. 
 
The combined vehicle and driver ID is a unique NEDAP patented feature. Optionally the vehicle-ID can 
be sacrificed if more information from the personal ID card is required. 
 
The following personal ID card types are identified with the Boosters. 
 
• Prox-Booster NEDAP, EM and HID PROX 
• Smartcard-Booster MIFARE, HID iCLASS, ISO14443A and ISO15693 
• Transition-Booster all of the above 
 
 
 
This device complies with part 15 of the FCC Rules and to RSS210 of Industry Canada.   
Operation is subject to the following two conditions: (1) this device may not cause harmful  
interference, and (2) this device must accept any interference received, including interference   
 

 

that may cause undesired operation. 
Changes or modifications not expressly approved by the party responsible for compliance could 
void the user's authority to operate the equipment.
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2 INSTALLATION 

2.1 DIMENSIONS 
The Boosters are easily mounted to the inside of the car’s windshield by means of suction cups. Users 
should ensure the visual contact between the Booster and any TRANSIT reader is unobstructed with 
items such as stickers or metallized windshields (see also chapter 2.3 about solar control windshields). 
Note that the Booster's suction cups must be faced toward the reader to achieve maximum reading 
distance. 
 

    

Dimension  millimeters inches 
Overall length X 116 4.57 
Overall width Y 72 2.83 
Overall height Z 31 1.22 
Body height Z1 26 1.02 
    

Booster Dimensions 
 

2.2 TEMPERATURE CONSIDERATIONS 
The Booster is designed to operate within the extreme temperature ranges, which often occur behind a 
vehicle’s windshield during the winter or summer seasons (-20°C to 85°C / -4°F to +185°F). However the 
personal identification card inserted in the Booster may not be designed to withstand such temperatures 
and could suffer damage as a result. 
 
Nedap advises to remove the personal identification card when not in use.  
 
CAUTION: DO NOT LEAVE CARD IN ACCESS DEVICE WHEN LEAVING THE VEHICLE, AS THIS 
PRESENTS A SECURITY RISK. 
 
CAUTION: DO NOT LEAVE CARD IN ACCESS DEVICE FOR LONG PERIODS OF TIME IN EXTREME 
HEAT, AS THIS MAY DAMAGE THE CARD. 
 

2.3 SOLAR CONTROL WINDSHIELDS 
From 1997 onwards several car manufacturers introduced vehicles with solar control windshields. The 
solar control windshields are equipped with a metalized coating, which can block the TRANSIT signal 
from the Booster mounted on the inside of the windshield of the vehicle. 
Most of these windshields have a metal free zone where transponders can be mounted. The metal free 
zone of metalized windshields is most often found in the middle of the windshield behind and slightly 
below the rear view mirror. In vehicles manufactured after 1998 the metal free zone should be indicated 
on the window. 
We advise the owner to contact the local car dealer if it is not clear where the aperture is exactly 
positioned in a certain vehicle and where the transponder should be mounted. 
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3 SMARTCARD CONFIGURATION 
The Smartcard-Booster and the Transition-Booster can be configured by means of a configuration card. 
This configuration card is a Mifare Classic 1K or 4K card that is programmed with the configuration 
settings. 
 
Configuration is only required if the factory default settings are not sufficient. The default settings are 
described in chapter 3.2.3. 
 

3.1 CONFIGURATION PROCEDURE 
Every Booster used in the application should be configured with the configuration card. The simple 
configuration procedure is described below. 
 
Insert the configuration card in the Booster and push the button. The Booster sounds the buzzer with an 
increasing frequency (♪ ♪ ♪) to indicate that the configuration settings have been accepted.
 

3.2 HOW TO CREATE A CONFIGURATION CARD 
NEDAP has developed a software application that allows system integrators to create configuration 
cards. This software can be downloaded from our website www.nedapavi.com. 
 

 
Smartcard-Booster Config software 
 

                                                      
 See chapter 6 for details about the buzzer indications. 

 

 

http://www.nedapavi.com/
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3.2.1 TARGET DEVICE 

The Booster Configuration software can be used to configure a number of different devices. The user-
interface is adapted to the selected target device. Select in the ‘Target’ menu which device you are about 
to configure. 

 Smartcard Booster 
 Transition Booster 
 Prox Booster EM4x50 not explained in this manual 
 Multi-Technology Reader Module see chapter 4 

 
 

3.2.2 CREATION PROCEDURE 

Follow the procedure below to create a configuration card with application specific settings. 
1. Specify OPERATING MODE (see chapter 3.2.2.1) 
2. Specify FRAME LENGTH (see chapter 3.2.2.2) 
3. Specify HIGH FREQUENCY settings (see chapter 3.2.2.3) 
4. Specify LOW FREQUECY settings (only for Transition-Booster) (see chapter 3.2.2.6) 
5. Save the configuration settings into a file. 
6. Write the configuration into a blank Mifare Classic 1K or 4K card. 
 
 
3.2.2.1 OPERATING MODE 

Booster (only Driver-ID) 
Up to 16 bytes of data from the personal identification card is read. The Vehicle-ID is omitted. 

 
Combi-Booster (Vehicle-ID + Driver-ID) 

Vehicle-ID combined with up to 11 bytes from the personal identification card is read. 
 

Tacho-Booster (Vehicle-ID + Driver-ID + Tacho-Counter) 
Vehicle-ID and Driver-ID combined with Tacho-Counter value. If this option is selected than 
automatically extended-length is selected. 

 
 
3.2.2.2 FRAME LENGTH 

This affects the length of the message sent from Booster to TRANSIT reader. 
 

Extended length (longer Driver-ID) 
Select extended-length in order to support all transponder types and maximum amount of data. 
The extended-length may be not compatible with older firmware versions in the TRANSIT reader. 
You might need to upload new firmware into the reader. 
The identification speed is a bit slower compared to applying standard-length. 

 
Standard length (backwards compatible, faster identification) 

Select standard-length in applications where the Boosters must be compatible with older types of 
transponders or where fast identification is important. 

 
Please note that when reading low-frequency cards with a Transition-Booster this setting is not used. 
For NEDAP and EM cards the extended-length is not required and therefore the Booster will 
automatically use standard-length (even if extended-length is selected in the configuration). 
For HID PROX the extended-length is required so extended-length is used automatically if such a card is 
identified (even if standard-length is selected in the configuration). 
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3.2.2.3 HIGH FREQUENCY 

Enable HID iCLASS CSN 
Enable or disable the reading of HID iCLASS transponders. Only the card serial number can be 
read from these transponders. 

 
Enable ISO14443-A / MIFARE 

Enable or disable the reading of ISO14443-A / Mifare transponders. 
 

Data to read from ISO14443-A / MIFARE 
For ISO14443-A cards only the card serial number can be read. The cascaded card serial number 
(e.g. used in Mifare UltraLight cards) is also supported. For MIFARE cards also other information 
from the card can be read. Select one of the following choices: 
 

 ISO14443-A card serial number 
 MIFARE UltraLight data (see chapter 3.2.2.4 for more details) 
 MIFARE Classic data from sector (see chapter 3.2.2.5 for more details) 

 
Enable ISO15693 / LEGIC CSN 

Enable or disable the reading of ISO15693 / LEGIC Advant transponders. Only card serial number 
can be read from these transponders. 

 
 
3.2.2.4 READING MIFARE ULTRALIGHT DATA 

The Mifare UltraLight transponders’ 512 bit EEPROM memory is organized in 16 pages with 4 bytes 
each. 
 

Page Number 
Page number to start reading from (in range from 0 .. 15). 

 
Data Length 

Number of bytes to read. The reading will wrap around to page number 0 if additional bytes after 
page 15 should be read. The maximum number of bytes to read is 16. 

 
Data Offset 

Number of bytes to skip reading (in range from 0 .. 8). 
 
Example: 

Data to read: MIFARE UltraLight data 
Page Number: 4 
Data Length: 4 
Data Offset: 2 
The settings above will read the data below shown in blue. 

 Byte 0 Byte 1 Byte 2 Byte 3 
Page 3 not read not read not read not read 
Page 4 skipped skipped DATA DATA 
Page 5 DATA DATA ignored ignored 
Page 6 not read not read not read not read 
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3.2.2.5 READING MIFARE CLASSIC DATA 

The Mifare Classic 1K and 4K cards are fully supported. Also other Mifare transponders which are 
compatible (such as Mifare DESfire and SmartMX) can be used. The memory is organized in sectors with 
blocks. Every block consists of 16 bytes. Only data from one block can be read. 
 

Sector Number 
Sector number to read data from (in range from 0 .. 39). 

 
Block Number 

Block number to read data from. The block number must be in range from 0 .. 3 for the first 32 
sectors. For the sectors 32 .. 39 the block number can range from 0 .. 15. 

 
Data Length 

Number of bytes to read. The reading will wrap around to page number 0 if additional bytes after 
page 15 should be read. The maximum number of bytes to read is 16. 

 
Data Offset 

Number of bytes to skip reading. 
 

Read Key 
Key A or Key B can be used to authenticate to the transponder. 
Select which key to use and the key itself. 

 
Example: 

Data to read: MIFARE Classic data from sector 
Sector Number: 2 
Block Number: 1 
Data Length: 8 
Data Offset: 4 
The settings above will read the data below shown in blue. 

Sector Block 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 
0 x x x x x x x x x x x x x x x x 
1 x x x x D D D D D D D D x x x x 
2 x x x x x x x x x x x x x x x x 

2 

3 x x x x x x x x x x x x x x x x 
 
 
3.2.2.6 LOW FREQUENCY 

The low frequency settings are only applicable for the Transition-Booster. 
 

Enable NEDAP PM 
Enable or disable the reading of NEDAP PM transponders. NEDAP PM cards are always 
transmitted to the TRANSIT reading using standard-length. See chapter 3.2.2.2. 

 
Enable EM4102 or compatible 

Enable or disable the reading of EM4102 and compatible transponders. EM4102 cards are always 
transmitted to the TRANSIT reading using standard-length. See chapter 3.2.2.2. 

 
Enable HID PROX 

Enable or disable the reading of HID PROX transponders. HID PROX cards are always transmitted 
to the TRANSIT reading using extended-length. See chapter 3.2.2.2. 
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3.2.3 DEFAULT CONFIGURATION 

In the table below the factory default configuration is shown. 
 
Configuration settings Default value 
Operating mode Combi-Booster (Vehicle-ID + Driver-ID) 
  

Frame length Extended-length (longer Driver-ID) 
  

Enable HID iCLASS CSN Yes 
Enable ISO14443-A / MIFARE Yes, ISO14443-A card serial number 
Enable ISO15693 / LEGIC Advant CSN Yes 
  

Enable NEDAP PM Yes 
Enable EM4102 or compatible Yes 
Enable HID PROX Yes 
 
 
Please use the table below to fill-in your application specific settings. 
 
Configuration settings Value 
Operating mode  
  

Frame length  
  

Enable HID iCLASS CSN  
Enable ISO14443-A / MIFARE  

Data to read  
Sector number  
Block number  
Data length  
Data offset  
Read key A or B  

Enable ISO15693 / LEGIC Advant CSN  
  

Enable NEDAP PM  
Enable EM4102 or compatible  
Enable HID PROX  
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3.3 PROGRAM THE CONFIGURATION CARD 

3.3.1 USING THE PHILIPS PEGODA PROGRAMMER 

3.3.1.1 REQUIREMENTS 

This requires a Philips Pegoda Mifare programmer to be connected to a USB port on 
your computer. In the ‘Pegoda’ menu of the configuration software click ‘Connect’ to 
connect to the programmer. 
Once the connection has been established and all configuration settings are entered, 
place an empty Mifare Classic 1K or 4K transponder card on the Pegoda unit. 

 
3.3.1.2 PROGRAMMING 

To program the configuration into the Mifare card click ‘Write configuration into card’ in the ‘Pegoda’ 
menu. The message ‘Configuration written into mifare card’ should appear to indicate that the 
programming action was successful. 
 
The software will warn you with the message ‘Overwrite configuration card’ if there is already a 
configuration on the Mifare card. Click ‘Yes’ to proceed and overwrite the configuration on the card or 
click ‘No’ to abort. 
 
3.3.1.3 READ BACK 

It is also possible to read back what configuration is programmed into a configuration card. Click ‘Read 
configuration from card’ in the ‘Pegoda’ menu to do that. 
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3.3.2 USING ANOTHER MIFARE PROGRAMMER 

If there is no Philips Pegoda Mifare programmer available you can use any other Mifare programmer to 
write the configuration into a Mifare classic card. 
 
The configuration data should be written into sector 1 of a Mifare Classic 1K or 4K card. The content of 
the configuration sector 1 is not explained, but can be shown by the configuration software by clicking 
‘Show configuration details’ in the ‘Expert’ menu. 
 

 
Configuration Data 
 
 
Sector 0 is reserved for MAD (Mifare Application Directory). If the MAD is programmed, the Nedap 
configuration segment should have application id 517F. 
 
 
3.3.2.1 COPY TO CLIPBOARD 

Copy the configuration data to clipboard by clicking ‘Copy to clipboard’ in the ‘Edit’ menu.  
 
 
3.3.2.2 CUSTOMIZING VIEW 

In the ‘View’ menu the viewing can be customized in such way that it best matches your programming 
software. 
Click ‘Change Hex Prefix…’ to specify a specific prefix that is shown before every configuration data byte. 
Below is shown the configuration data with prefix ‘0x’. 
 
0x77 0x77 0x77 0x2E 0x6E 0x65 0x64 0x61 0x70 0x61 0x76 0x69 0x2E 0x63 0x6F 0x6D  
0x4E 0x01 0x01 0x07 0x07 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x4E  
0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00  
0xA0 0xA1 0xA2 0xA3 0xA4 0xA5 0x78 0x77 0x88 0x00 0xB0 0xB1 0xB2 0xB3 0xB4 0xB5 
 
Besides the hex prefix also the byte numbering can be changed from within the ‘View’ menu. 
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3.4 TESTING THE CONFIGURATION 
The ISO14443-A / Mifare settings can be tested before loading it into the Smartcard-Booster or 
Transition-Booster by using the Philips Pegoda reader. 
From the ‘Pegoda’ menu choose ‘Test configuration (only ISO14443A)’. 
Place the Mifare transponder on the Philips Pegoda reader and click the ‘Read’ button. This transponder 
would normally be read by the Booster. 
 

 
Configuration Test 
 
 
If the card is not read or if the wrong data is shown under DRIVER-ID then check if the configuration 
settings are correct. Remember that only Mifare cards can be tested this way. 
 
 
 

3.5 CONFIGURATION FILES 
Your configuration can be saved into a so-called Smartcard Booster Config File (*.sbcf). These files 
contain all the configuration settings as you have defined them. Saved Config Files can be easily opened 
from within the File menu. 
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4 MTR CONFIGURATION 
The Multi-Technology Reader Module (MTR) is especially designed to read low-frequency proximity 
cards and ISO compliant smartcards directly on the TRANSIT Entry reader at short range (without 
Booster). 
 
The MTR is configured in exactly the same way as the Smartcard Booster. Refer to chapter 3 on page 5 
for more information about the configuration procedure. 
 
For more details about the TRANSIT Entry reader and the MTR refer to the separate documentation. 
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5 IDENTIFYING THE BOOSTER WITH A TRANSIT 

5.1 HOW TO USE THE BOOSTER 
Place the Booster on the inside of the windscreen of your vehicle as described in chapter 2. The driver 
inserts his personal identification card and activates the Booster’s button. 
A beep should indicate that the card was successfully read. A low beep may indicate that reading failed.
The TRANSIT reader can identify your card up to a distance of 10 meters (=33 ft). 
After 5 seconds the Booster returns into standby mode. 
The driver should remove his personal identification card from the Booster when leaving the vehicle. 
 

5.2 READER OUTPUT 
The Prox/Smartcard-Booster is a battery operated passive tag. The information from the tag is sent to the 
reader by a method called modulated backscatter. This means that the 2.45GHz signal coming from the 
reader's antenna is modified in such way that it can be recognized by the reader.  
 
The examples below assume that a TRANSIT PS270 reader with P81 firmware is used and show the 
messages transmitted on the RS-232 interface to a host system (TXD). Refer to the TRANSIT firmware 
manuals for more details about the reader communication protocol. 
 
Combi-Booster mode (Vehicle-ID + Driver-ID) 
The Booster cannot be identified until the driver inserts his personal identification card and pushes the 
Booster’s button. Once the button is pushed the Booster reads the personal identification card and 
beeps  upon a successful read. Both vehicle-id and driver-id are transmitted to the host system for 5 
seconds. Afterwards the Booster automatically deactivates again. 
Example: vehicle-id = 123, driver-id = E4947C46, TXD = Y000000012300000000000000E4947C46CRLF  
 
If 'Standard-length' is configured, the following message is transmitted to the host. 
Example: vehicle-id = 123, driver-id = E4947C46, TXD = U000000012300E4947C46CRLF 
 
 
Booster mode (Only Driver-ID) 
The Booster is 'sleeping' until the driver inserts his personal identification card and pushes the Booster’s 
button. Once the button is pushed the Booster reads the personal identification card and beeps  upon a 
successful read. The data is transmitted to the host system for 5 seconds. After that the Booster 
automatically deactivates again. 
Example: driver-id = 871111111117100944, TXD = Z00000000000000871111111117100944CRLF  
 
If 'Standard-length' is configured, the following message is transmitted to the host. 
Example: driver-id = 871111111117100944, TXD = U00871111111117100944CRLF 
 
 
Tacho-Booster mode (Vehicle-ID + Driver-ID + Tacho-Counter) 
The Booster cannot be identified until the driver inserts his personal identification card and pushes the 
Booster’s button. Once the button is pushed the Booster reads the personal identification card and 
beeps  upon a successful read. Both vehicle-id, driver-id and tacho-counter are transmitted to the host 
system for 5 seconds. Afterwards the Booster automatically deactivates again. 
Example: vehicle-id = 123, driver-id = E4947C46, tacho-counter = 1234, 
TXD = X000000012300E4947C468000001234CRLF  
 

                                                      
 See chapter 6 for details about the buzzer indications. 
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6 BUZZER INDICATIONS 
The Booster's built-in buzzer gives audible feedback upon various conditions. The table below describes 
the buzzer indications. 
 
Buzzer Description 
1 beep Transponder read 
1 short low beep  Transponder not read (not in configuration) 
  
3 beeps increasing frequency ♪ ♪ ♪ Configuration card accepted 
  
6 beeps increasing frequency Power on (Smartcard-Booster / Transition-Booster / MTR) 
3 beeps Power on (Prox-Booster) 
  
 

7 BATTERY REPLACEMENT 
The Smartcard-Booster and Transition-Booster contain two replaceable non-rechargeable lithium AAA 
batteries. The average lifetime of these batteries is approximately 5 years. When replacement becomes 
necessary follow the procedure below. 
 
1. Unscrew the four screws on the bottom of the Booster and carefully open the housing. 
2. Remove both batteries. Follow local environment protection laws / regulations for disposal of used 

batteries. 
3. Replace with two new batteries of same type. Make sure that the polarity matches the indicated 

polarity. 
4. Before closing the housing make sure that the coil (displayed in red in the picture below) is positioned 

correctly on the three stand-offs. 
5. Place the cover on the housing and tighten the four screws back in place. 

 
 
The Prox-Booster contains a non-rechargeable lithium battery which is soldered in place. The average 
lifetime of this type of battery is approximately 5 years. When replacement becomes necessary, contact 
Nedap about the battery replacement program. 
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A TECHNICAL SPECIFICATIONS 
Dimensions 116 x 72 x 27 mm (4.6 x 2.8 x 1.1 in)  
Weight 120 gram (4.2 oz)  
Protection IP32 Approx. NEMA 2 
Operating temperature -20°C … +85°C (-4°F … +140°F)  
Storage temperature -40°C … +85°C (-40°F … +140°F)  
Color Grey RAL 7035 
Relative humidity 10% … 93% non-condensing 
Identification range Typically 10 meters (33 ft) line-of-sight required 
 
 
 

B PART NUMBERS 
PROX/SMARTCARD-BOOSTERS 

 
Prox-Booster part number: 9895744 

 
Smartcard-Booster part number: 9895337 

 
Transition-Booster part number: 9895752 

 
 
READER 

 

TRANSIT PS270 long range reader part number: 9990410 

 

TRANSIT Entry reader part number: 9876200 

 
ENTRY READER ACCESSORIES 

 
MTR Module  part number: 7816650 
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